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1.1	 General
This manual presents detailed user instructions on the installation, operation, and maintenance of an Automatic 
Raingage. The FAO Nile Basin Water Resources Project has assembled this system by combining individual parts 
from various suppliers, with the aim of arriving at a cost effective instrument for automatic rainfall recording. 

The reader is advised to study this manual carefully before starting to work with the instrument. We have worked 
hard to present the user instructions as concise as possible, without compromising on the necessary detail. 

Main purpose of the automatic raingage is to collect continuous high quality data on the duration, intensity, and 
total amount of rain events. Precipitation is among the dominant forcing parameters of hydrologic processes, and 
comprehensive knowledge of the rainfall regime is essential for assessing and predicting hydrologic responses. 
Rainfall information is also routinely used for:

•	 Agricultural planning;
•	 Irrigation scheduling;
•	 Climate change assessment, etc.

Apart from providing continuous information, the automatic raingage also facilitates automated data process-
ing. This results in much simplified procedures for data retrieval, processing, quality control, and storage in a final 
database. 

Introduction

Introduction

Box 1 Automatic Rainfall Monitoring Network for Collecting Ground Truthing for Rainfall Estimation 
Algorithms Using METEOSAT Imageries

METEOSAT satellite images provide an important additional source of information on rainfall events. It 
concerns a low-cost, more or less continuous temporal and spatial data layer. Unfortunately, the development 
of operational algorithms for satellite based precipitation estimation is hindered by the lack of accurate ground 
truthing data. The rainfall monitoring system described in this manual offers the possibility to establish a 
high-quality high-density rainfall-monitoring network at a limited budget. Such a network could serve to 
provide the required ground truthing to make fully use of the METEOSAT imageries for rainfall estimation.

1.2	 Individual Components of the Automatic Raingage
The automatic raingage comprises of 2 main elements: (1) a tipping bucket rain recorder made by Texas Electronics, 
shown in figure 1, and (2) a HOBO Event Logger manufactured by Onset Electronics, pictured in figure 2. The Event 
Logger is placed inside the raingage.

A separate unit is used for offloading data from the Event Logger and bringing it to a PC for data processing. This 
is the HOBO Shuttle data transporter, also made by Onset Electronics, and presented in figure 3.
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Figure 1: Tipping Bucket Rainfall Recorder

Figure 3: HOBO Shuttle

Figure 2: HOBO Event Recorder

1.3	 Overview of the Contents of this Manual
The installation and operation of the tipping bucket raingage is discussed in chapter 2, while chapter 3 deals with the 
installation, operation, and maintenance of the HOBO Event logger. All user information related to the HOBO shuttle 
is covered in chapter 4. Data retrieval and processing are discussed in chapter 5, while some useful addresses are 
listed in chapter 6.

Introduction
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Tipping Bucket Raingage

2.1	 General
The Automatic Raingage includes a TE525 tipping bucket rainfall recorder made by Texas Electronics, USA. It is a 
smaller adaptation of the standard US Weather Bureau tipping bucket raingage. The instrument is equipped with two 
collectors of known volume, connected to each other by a horizontal axis balanced on a fulcrum. Rain is collected 
with a conventional funnel of standard diameter and directed to one of the buckets. Once this is full, it becomes 
unstable and tips. This empties the full bucket and brings the other into filling position. Each tip generates an elec-
tric pulse, which is recorded by the Event Logger. A pulse represents 0.254 mm (0.01 inch) of rainfall, and the total 
rain volume is thus obtained by aggregating the 0.254 mm pulses in the requested time interval. 

2.2	 Installation
The rainfall recordings should be representative for the surrounding area. The user is therefore advised to observe 
the following guidelines when selecting the location for the rain gauge:

Select a site that it is representative for the area. Wind speed at gauge level should be uniform, and preferably •	
as small as possible; 
Remove all obstacles in the vicinity of the gauge that could create wind effects, as these may influence the rain •	
catch; the distance of the gauge to obstructing objects should be at least 4 times the height of the obstruc-
tion;
No objects should intercept precipitation that should reach the gauge;•	
The area surrounding the gauge should be relatively level, and the gauge orifice should be horizontal; the lip •	
of the funnel should be at 50 cm above the ground.
The ground surrounding the gage should be covered with short grass, equivalent natural vegetation, or gravel •	
to avoid splashing of rainfall into the gage; the ground surface around the gage should not be paved.

The TE525 Rain Gauge mounts to a 2-inch pipe. Drive the pipe into the ground to acquire a firm vertical post, and 
use the enclosed hose clamps to mount the gauge to this post. The lip of the funnel should be 50 cm above ground 
level and at least 5 cm above the post. Level the gauge after mounting it.

Note: before final leveling, press one of the buckets down against its stop to make sure that the buckets are NOT 
hung up in the center.

Connection of the raingage to the Event Logger is discussed in paragraph 3.2.

2.3	 Operation
Operation of the TE525 Tipping Bucket Rain Gauge is fully automatic and does not require user interventions. 

2.4	 Maintenance
Maintenance is limited to the following. At every visit to the raingage site:

Check if the raingage is securely attached to the post, and that the post is firmly implanted in the ground;•	
Check if the cable from the Event Logger to the TE525 are firmly connected; If necessary, clean contacts;•	
Check if the funnel and bucket mechanism are clean; remove any leaves, dust, insects, or other foreign •	
material.

Perform a field calibration check every 12 months, as follows:

Tipping Bucket Raingage
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Tipping Bucket Raingage

Secure a metal or plastic can that can hold at least one liter of water;•	
Punch a very small hole in the bottom of the can;•	
Place the can on top of the funnel of the rain gage, and pour 0.5 liter of water into the can;•	
The hole is too large if it takes less than 40 minutes to empty the can;•	
This should result in 91 tips, plus or minus three;•	
If necessary correct the tipping mechanism. Adjusting screws are located on the bottom next to the large •	
center drain hole. One half-turn of both screws causes 2% to 3% change. Adjust both screws the same number 
of turns. A rotation clockwise increases the number of tips per 0.5 liter, while a rotation counter-clockwise 
decreases the number of tips.
Check and re-level the rain gage lid.•	

In principle no factory calibration is needed. In the unlikely event that such calibration would be required, the 
reader is requested to contact Texas Electronics.

2.5	 Trouble Shooting
Problem 1:	 No rainfall is recorded in spite of clear evidence of a recent rain event.
Remedy 1.1:	 Check if all wires are properly connected, both to the switch inside the raingage, and to the 
		  Event Logger. If necessary, clean the contacts.
Remedy 1.2:	 Check if the tipping mechanism in the rain gage is not blocked.
Remedy 1.3:	 Check the battery status of the Event Logger.
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HOBO Event Logger

3.1	 Description
The HOBO Event Logger is a compact datalogger that stores momentary contact-closure events. Only one time per 
event is stored to minimize memory usage. The logger has a capacity of 8,000 events, which is equivalent to 203.2 
cm of rainfall when connected to a 0.254 mm tipping bucket raingage. The Event Logger includes a compact, weath-
erproof case that can be mounted inside or outside the rain collector. 

The instrument is powered by a user-replaceable battery, which lasts 1 year. This replacement 3V lithium battery 
is similar to those used in calculators. The Event Logger has two memory modes: (1) stop when full, and (2) wrap 
around when full, also referred to as ring mode. The unit’s non-volatile EEPROM memory retains the collected data 
even if the battery fails.

3.2	 Installation

3.2.1	 Configuring the HOBO Event Logger
The BoxCar Pro software package is used to configure the HOBO Event Logger. Box 2 describes the installation 
instructions for BoxCar Pro.

HOBO Event Logger

Box 2: Installing BoxCar Pro

System Requirements

BoxCar Pro 4.0 requires a minimum system consisting of a 486 Mhz processor with at least 16 Mb of RAM 
running Windows 95/98 or later. The system must have at least one free COM port for serial communication, 
as well as a CD ROM drive.

Installation

Load the BoxCar Pro CD into the CD-ROM drive of your computer. Select Run from the Windows Start menu 
and navigate to your CD-ROM drive. Run the program named setup.exe. Follow the instructions.

Figure 4 shows the interface cable to connect directly between the HOBO Event Logger and the PC through a serial 
port. If you last used the serial port for a modem or mouse, it is necessary to reconfigure it before connecting the 
logger. To this end, first remove the modem or mouse, and then reboot the system.

Figure 4: Connection Cable between PC and HOBO Event logger
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HOBO Event Logger

Box 3: Testing the Communications Port

Select Test Port from the Help menu to test the communication port and the serial cable. Select a baud rate 
of 1200, click the port you want to test, and follow the instructions on the dialog, as shown below.

To configure the HOBO Event Logger, follow the instructions below:

Connect the interface cable to the logger; make sure the plug is firmly seated in the jag.•	
Start BoxCar Pro and select Launch from the Logger menu. This displays the launch dialog, as pictured in •	
figure 5.
Change the selections as appropriate.•	

The serial number of the HOBO Event Logger is indicated in the upper-right hand corner of the Launch window. 
This represents the unique datalogger ID, which is also included in the data export file, and can thus be used to 
distinguish between various stations. It is advised to record this serial number in a separated column of the Station 
table in the final Access rainfall database, linked to the associated station name

The Description field lists a brief description of the monitoring activity; Event Name holds the station name, while 
Event Value should be set to 0.254, representing 0.254 mm rainfall per tip. 

The Wrap around when full option causes the logger to record continuously, overwriting the oldest data points 
when full. The logger continuous logging until interrupted by a read-out or launch. If this box is not check, the log-
ger stops once its memory is full. 

When the Stealth Mode option is enabled, the logger does not blink its LED while logging. It is advised not to mark 
this box.
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HOBO Event Logger

The Delayed Start feature allows the user to postpone logging for up to three months after launching the 
instrument. It is advised not to check this box.

Selecting the Lockout after event mode instructs the logger to ignore events for a programmable period after 
an event is recorded. With a tipping bucket raingage, it is recommended to set the lockout time to one second to 
eliminate switch bounce.

Figure 5: Launch dialog window.

After setting the right configuration, click Start. A message box appears telling the user that all existing data on 
the logger will be erased. Click Yes to continue. Watch the launch process as shown in figure 6.

Figure 6: Progress of Launch Operation

Disconnect the logger. The instrument is now properly configured and ready for recording data. 
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HOBO Event Logger

Box 4: Use the HOBO Shuttle to Re-launch the HOBO Event Logger in the Field

The HOBO Shuttle allows retrieval of data without the necessity of bringing the logger back from the field.  
The HOBO Shuttle offloads the data on site, and synchronizes the system clock.

3.2.2	 Installing the HOBO Event Logger in the Tipping Bucket Raingage
Installing the HOBO Event Logger in the raingage is a simple and straightforward process. To this end, follow the 
steps outlined below:

Remove any external cables leading to the contacts in the raingage; the location of these contacts is indicated •	
in figure 7.
Connect the black and white input wires coming from the HOBO Event Logger to the contacts, as indicated in •	
figure 8; polarity does not matter. Be careful no to touch the input wires together as this will record an event.
Place the HOBO Event Logger inside the raingage; make sure the cable does not obstruct the tipping •	
mechanism. The completed installation is shown in figure 9.
Make sure not to tip the buckets in the installation process, as this will be recorded as a 0.254 mm rainfall •	
event.
Add the funnel, and attach the rainfall recorder to a mounting post.•	

 

Figure 7: Top View of Tipping Bucket Raingage with Free Contacts.

Tipping Buckets

Contacts
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HOBO Event Logger

 

Figure 8: Top View of Tipping Bucket Raingage connected to an External HOBO Event Logger.

 

Figure 9: Top View of Tipping Bucket Raingage Connected to a HOBO Event Logger Placed inside

3.3	 Operation
Operation of the HOBO Event Logger is fully automatic and does not require user interventions. The unit has a red 
LED (Light Emitting Diode) that blinks every two seconds while it is logging. The LED blinks four times faster when 
storing an event.

Always keep the logger’s protective case dry and closed, to avoid rain or moist from affecting the electronics.

Contacts

Contacts

HOBO Event Logger



15Manual

HOBO Event Logger

Data readout is accomplished using the HOBO Shuttle, and is discussed in chapter 4.

3.4	 Maintenance
The HOBO Event Logger does not require maintenance, apart from annual change of the battery. To this end, follow 

the instructions below:

Open the case by unsnapping the latch and lifting the lid. Unplug the 2.5 mm sensor cable. Hold the case upside 
down by the bottom, and firmly tap the open case into the palm of your hand until the circuit board dislodges. Remove 
the circuit board from its cover and then remove the battery by carefully pushing it out with a small, blunt instru-
ment. Be sure to install the new battery with its printed side away from the HOBO’s circuit board. The logger’s LED 
will blink three times after the battery has been installed.

When replacing the battery, the moisture-absorbing desiccant pack inside the case should also be changed.

3.5	 Trouble Shooting
Problem 1:	 The electronics in the case have become wet.

Remedy 1:	 Remove the battery and dry the circuit board completely with a hair dryer. Reinstall the battery. 		
		  Close the case properly.

Problem 2:	 No rain is recorded in spite of clear evidence of a recent rain event.
Remedy 2.1:	 Check if all wires are properly connected, both to the switch and the logger.
Remedy 2.2:	 Check the battery of the logger with the HOBO Shuttle, as discussed in chapter 4. If necessary, 		

		  replace the battery following the instructions in paragraph 3.4.
Remedy 2.3:	 Reconfigure the logger following the instructions in paragraph 3.2.1. Please note that all data 		

		  stored in the logger is erased in this process.
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4.1	 Description
The HOBO Shuttle is a compact data retrieval unit for transferring electronic rainfall recordings from the field to 
the office. Use of the shuttle eliminates the necessity of bringing the loggers back to the office, or taking a laptop 
computer into the field. The HOBO Shuttle further serves to check the battery status of the loggers, allowing their 
timely replacement in the field. The shuttle also tests the HOBO Event Logger, re-launches it, and synchronized its 
internal clock. 

The shuttle contains 486 Kb of non volatile memory, which can store up to 51 full HOBO Event Loggers.

4.2	 Configuration
The HOBO Shuttle is factory-configured and immediately ready for use. However, the user should launch the unit 
before bringing it into the field to synchronize its system clock, which is then used to reset the logger’s clocks.

Connect the shuttle to the PC using the interface cable, as discussed in paragraph 3.2.1. Start BoxCar Pro and 
select Launch from the Logger menu. BoxCar Pro displays the clock adjustment and the battery’s percentage level, 
as shown in figure 10. 

HOBO Shuttle

HOBO Shuttle

Figure 10: HOBO Shuttle Launch Dialog

It is important that the battery level of the HOBO Shuttle exceeds 40%, since lower values can lead to data 
corruption and loss. Therefore, to ensure data integrity, replace the battery when its level drops below 40%. This 
process is similar to battery replacement of the HOBO Event Logger, which is described in paragraph 3.4.

4.3	 Operation

4.3.1	 Offloading Data on Location and Re-launching the HOBO Event Logger
To retrieve data from a HOBO Event Logger on location, please follow the steps below:

Remove the HOBO Event Logger from the raingage; make sure not to tip the buckets in this process, as this 1.	
will be recorded as a 0.254 mm rain event.
Make sure the shuttle’s LEDs are not flashing before connecting the interconnect-cable. If the shuttle’s LEDs 2.	
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HOBO Shuttle

are blinking, wait until the ‘Com failure’ LED flashes, and press the shuttle button to clear the flashing LED.
Plug the 30 cm long interconnect-cable into the 3.5 mm jacks of the HOBO Event Logger and the HOBO Shuttle, 3.	
as shown in figure 11. 
Press the shuttle button to start offloading data. The orange ‘offloading’ LED will blink until all data is 4.	
retrieved.
Once the offload is complete, the shuttle will test the logger’s battery status. If the battery level is less 5.	
than 30%, the red ‘Change battery’ LED will blink. Change the logger’s battery following the instructions in 
paragraph 3.4.
After completing the battery test, the shuttle will test the operation of the HOBO Event Logger. The orange 6.	
‘Testing’ LED will flash every half a second as it checks the logger current status. If the logger is operating 
properly, the LED will double flash every time it sees an event with the HOBO Event Logger. Test the operation 
of the logger by tipping the buckets. Press the shuttle button when you have verified proper operation of the 
Event Logger.
The shuttle will now re-launch the HOBO Event Logger and synchronize its system clock. While re-launching, 7.	
the orange ‘Relaunching’ LED will blink. If the process is completed, the shuttle will flash the green ‘Successful’ 
LED.
Press the shuttle button. All data is now offloaded to the shuttle, and the logger has been tested and 8.	
re-launched. Disconnect the interconnect-cable.

 

 

Figure 11: Connecting the HOBO Shuttle to the HOBO Event Logger

The LED indicators of the HOBO Shuttle are presented in figure 12. To continue offloading, the shuttle button 
requires pressing at several occasions, as indicated in this figure.

•	 Shuttle Full
•	 Offloading
•	 Change Battery
•	 Testing
•	 Relaunching
•	 Comm failure
•	 Successful

Press shuttle button to continue
Press shuttle button to continue

Press shuttle button to continue
Press shuttle button to continue

Figure 12: LED Indicators of the HOBO Shuttle

Interconnect-cable
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Box 5: Pressing the Shuttle Button without Connecting to HOBO Event Logger or PC

Pressing the shuttle button before plugging in the interconnect-cable, properly connected to PC or HOBO 
Event Logger, can result in operational failure including loss or corruption of data.

The Trouble Shooting paragraph discusses several potential offload failures and proposed remedies.

4.3.2	 Transferring Data from HOBO Shuttle to PC
Upon return in the office, the data retrieved from the various HOBO Event Loggers on location require transfer to a 
PC. To this end, connect the shuttle to the PC using the interface cable, as discussed in paragraph 3.2.1. Start Box-
Car Pro and select HOBO Shuttle Readout from the Logger menu. Follow the instructions on screen and watch the 
progress bar until data offloading is complete. Use the Save As dialog to name the data file according to the conven-
tions of your organization, as indicated in figure 13.

Figure 13: Save-as Dialog to Name the Data File

This completes the data retrieval process.  BoxCar Pro now re-launches the shuttle, synchronizes its system clock, 
and erases all data. The shuttle is once more ready for use in the field.

Data processing is discussed in chapter 5.

4.4	 Maintenance
The HOBO Shuttle is essentially maintenance free, apart from periodic change of the battery. To this end, follow the 
instructions presented in paragraph 3.4.

HOBO Shuttle
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4.5	 Trouble Shooting
Problem 1:	 After offloading data, the shuttle’s red ‘Shuttle full’ LED flashes.

Remedy 1:	 The shuttle is full, and has no memory left for offloading another Event Logger. Bring the 
		  shuttle back to the office and transfer the data to a PC. 

Problem 2:	 The shuttle’s ‘Com failure’ LED blinks in the data retrieval process.
Remedy 2:	 Check if the interconnect-cable is properly plugged into the jacks of the HOBO Event Logger 
		  and the HOBO Shuttle. Press the shuttle button to clear the communication failure, and re-attempt 	

		  data offloading.

Problem 3:	 An error message appears while offloading data from the shuttle to PC.
Remedy 3:	 Retry the retrieval process by activating HOBO Shuttle Readout from the Logger menu.

HOBO Shuttle
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Data Processing

5.1	 Introduction
BoxCar Pro software is used to retrieve the rainfall recordings from the HOBO Shuttle. Paragraph 4.3.2 describes 
this process in detail. The user has to perform, however, a number of additional data filtering and processing opera-
tions before storing the recordings in the final database. These steps are discussed in this paragraph.

The final product is a time series in ASCII format, at the desired time resolution. In view of the wide variety of 
existing database structures, it is left to the user to convert this output file into the appropriate database format, and 
finally appended it to the rainfall tables of his database of choice.

5.2	 Filtering the Raw Data Series
The HOBO Event Logger only stores the time of occurrence of a tipping event, without aggregating for predefined 
time intervals. Hence, a graph of the unprocessed data series shows the cumulative rainfall recording over time. 

Select Open from the File menu to open a data file. In the Open dialog, select the file that contains the relevant 
data, and click the Open button. A window appears similar to Figure 14. The upper part of the screen presents the 
aggregated rainfall series, while the lower window lists the Hobo data files that are stored in the designated folder. 
One can open an alternative file from this list by double clicking it.

Data Processing

Figure 14: Presentation of Unprocessed Data File

In this particular example, the horizontal axis shows the date, while the vertical axis represents the cumulative 
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Data Processing

rainfall in mm. 

It is likely that the user is not interested in the cumulative precipitation over a longer time period. Instead, most 
hydrologic applications require aggregated values for time steps of 5-minutes, 1 hour, and 1 day. BoxCar Pro filter 
options enable the extraction of these requested time series. To this end, click a series with the right mouse button, 
resulting in a window similar to figure 15.

Figure 15: Activate Filter Option

After selecting and clicking Filter Series…, a dialog like figure 16 shows up
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Data Processing

Figure 16: Filter Series Dialog Defining Daily Totals

Define the appropriate time step in this dialog, and select the Event Sum option. Click OK, and the rainfall is 
totaled for the requested temporal resolution, in this particular example for a period of 1 day. Figure 17 displays the 
resulting series.

Figure 17: Rainfall Recording Filtered to Daily Values.
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Data Processing

Box 6: Changing the Legend Title of a Data Series

Select a data series by clicking it with the mouse; then press the left mouse button to change its properties. 
Navigate to Series, “Name of the Series”, and select Properties. The below window appears. Modify the series 
name in the Name text box.

Repeat the above exercise for hourly and 5-minutes intervals, as shown in figures 18 to 23.

Figure 18: Filter Series Dialog Defining Hourly Totals
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Data Processing

Figure 19: Rainfall Recording Filtered to Hourly Values.
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Data Processing

Figure 20: Zoomed Rainfall Recordings Filtered to Hourly Values

Figure 21: Filter Series Dialog Defining Five-Minutes Totals

Use the Zoom tool to display the data series in more detail, as shown in figure 22.
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Data Processing

Figure 22: Zoomed Rainfall Recordings Filtered to Five Minutes Values

5.3	 Exporting the Filtered Data Series
After filtering the cumulative data to the appropriate time intervals, the time series need to be exported to an ASCII 
text file for further processing. The appropriate procedures to this end are presented in this paragraph.

Select Export from the File menu. A window appears as in figure 23. Navigate to Custom… and double click. The 
resulting dialog is presented in figure 24 .
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Data Processing

Figure 23: The Export Options from the File Menu.
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Data Processing

Figure 24: The Custom Export Dialog with the Daily Sum Series Highlighted.

Highlight the data series at the requested time interval. Then click Preferences to define the export format. The 
associated dialog is pictured in figure 25.

Figure 25: The Export Preferences Window

Click he Change Export Date/Time Preferences… button to select the appropriate data/time export format, as 
indicated in figure 26. Click OK. Set Tab as separator. A sample of the output format is shown in the lower left hand 
corner. Click OK. 
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Figure 26: Export Date / Time Preferences

Then click Export in the Export dialog. The Save As window appears as shown in figure 27. Navigate to the 
dedicated directory, and name the export file. 

Figure 27: Save As Dialog

The data series is now converted to ASCII text format, and the export process is completed. Use Notepad to check 
this output file, a typical example of which is shown in figure 28. 
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Figure 28: Sample Output File in ASCII Text Format of Daily Rainfall.

Please note that the serial number of the HOBO Event Logger is included in the output file. This number represents 
a unique and unambiguous data logger ID that can be used to distinguish between various stations. 

Figures 29 to 32 present the export results for data series with an hourly and five-minutes time interval.
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Figure 29: The Custom Export Dialog with the Hourly Sum Series Highlighted.
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Figure 30: Sample Output File in ASCII Text Format of Hourly Rainfall.

Figure 31: The Custom Export Dialog with the Five Minutes Sum Series Highlighted.
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Figure 32: Sample Output File in ASCII Text Format of Five Minutes Rainfall.

5.4	 Quality Control and Final Storage in Database
Due to the wide varieties of quality control procedures and databases (for example Hydata, MS Access, SQL Server, 
Oracle, etc.), this manual does not cover the final steps in the data trajectory: quality control and final storage in a 
dedicated database. The user is advised to apply the established practices of his or her organization.

5.5	 Trouble Shooting
Problem 1:	 The daily data record shows a double day after filtering the original series.

Remedy 1:	 This problem is mostly likely due to the ‘daylight saving’ settings of your PC, which are automatically 
followed by Windows. Select a region without ‘daylight saving’, for example Hawaii. Go to Control Panel from the 
Settings option of the Start menu. Select Date/Time. Navigate to Hawaii on the Time-zone dialog. Click Apply, and 
reboot your computer. Filter the raw data series using this new time setting. Reset the original time settings if the 
problem is solved.


